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- the past

In the earliest centuries of mankind, our ancestors entertained themselves by throwing small
marked pieces of bone and wagering on their fall. These implements eventually became what
we call dice.

Sometime later, the Chinese changed the dice into tiles, and created a game we call dominos.
In 1120 ad, during the reign of Siuen-ho, dominos became standardized in the form we still
know today. But over time, new and different versions of dominos came to be played in the
provinces.

In the early part of this century, Joseph I> Babcock, an American businessman living in
Shanghai, made a study of one of those games. It was called ma chiang, ma cheuk, or ma
ch’iau, all of which are dialect names for “sparrow,” the “bird of 100 intelligences.” In 1920,
he brought the game and its colorful tiles to the West under the name Mah-Jongg. Mah-

Jongg became a huge fad in the English-speaking world and has retained its artraction ever
since.

But Mah-Jongg is not the only variation of this ancient and intriguing obsession. Now from
the Orient come Shanghai and Dragon’s Eye. ..




- ShanGhal

OBJECTIVE

The object of Shanghai is to remove all the tiles from the layout, one pair ar a time. To be removed, both
tiles in a pair must be free at the same time and must match. A tile is considered free if there’s nothing on
top of it, and if it can slide out to the left, to the right, or both. A tile which can only slide toward the top or
the bottom of the screen is not free. |

There are usually four of each rile, which can be removed as two matching pairs. In some tile sets, there are
four unique tiles. Each of these tiles matches any other tile in its set. For example, in the Fantasy tile set, the
Court tiles consist of the King, Queen, Princess, and Jester; any Court tile matches any other Court rile,

getting started

If you do not select a layout, you default to the Shanghai layour, using the Mah-Jongg tiles. To remove a pair
of tiles during the game, simply select the two tiles you want. To select a tile, click on it with the mouse.
(With the DOS version you can also click on the rile with the joystick button, or move the cursor onto it
with the arrow keys and hit Enter.) If a tile is eligible to be removed, it will become highlighred. Sc]:ﬂin' a
matching tile removes the pair. (With the Mac version you need to double-click the matching tile to remove
the pair.) Continue to remove matching pairs until the layout is gone.

As you remove tile pairs, the game tells you how many tiles still remain in the layout. Thus, if you see "32"
at the right corner of the menu bar, you know that there are still 32 tiles (16 pairs) to be removed.




If you change your mind abour selecting a tile, just click on it again, and it will become unhighlighted —
or simply select another eligible tile. If you choose an inappropriate tile, it will automatically become

unhighlighted.

changing Layouts and tile sets

You can play Shanghai with any of thirteen layouts 1sing any of eight tile sets. To change layouts or tile sets,
select the Options menu and then select Load Layout or Load Tile Set. You can then select the new layout
or tile set by selecting the appropriate name and then the OK burton. Note that if you select a new tile set
in the middle of a game, you will automatically start a new game.
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- StRateGgy hints FOrR shanghai

There are three levels of difficulty in the layouts. (Each group below is listed alphabetically.)

EASY ADVANCED MASTER
* Boar * Dog * Horse
* Dragon * Monkey e Ox
= Rar * Ram * Rabbit
* Snake * Rooster * Tiger
* Shanghai

Concentrate on removing tiles that are blocking the most moves. There are few such tiles in the Easy
layouts, several key blocking tiles in the Advanced layouts and multiple blocking tiles in the Master
layouts.

Examine each layout carefully before starting play to find as many marching pairs as possible. Also, in
the Advanced and Master layouts, check for riles that you will need to unblock as soon as possible. It is
often better to concentrate on long rows than on tall stacks.

Always check for triples. If you've found a pair to remove, look for a third (or fourth) free tile that also
matches. If you take two out of three matching tiles, make sure the one you leave is blocking the fewest
important tiles. If you're not sure what to do with a triple, leave it and make another move instead.

[t you see all four tiles of one kind free at the same time, remove them so they're out of your way.

Look ahead as many moves as you can. |




—- the dragon's €ve

In a time now clouded to both East and West, the Red Empress bore her husband twin children — a boy
with flashing black eyes, and a girl with eyes as pale as ivory. But in the earliest days of the children’s lives,
the girl-child was stolen away. Though the Emperor strongly suspected a Magician who bore him an ancient
grudge, a complete search of the empire yielded no trace of the little girl.

Twenty years later, the Red Emperor died, and his son, now grown, succeeded him. But on that same night,
a fearsome roar echoed from the earth, and in the following days terrified peasants reported that a dragon
had appeared upon the land. The new Emperor did not fear dragons, for he had been well taught, and knew
that the power of the beasts could be used for good as well as ill. And it was well with him that he thought
so, for the next evening, as he strolled alone among the far reaches of his estates, he stepped out from a for-
est and found himself face to face with the crearure.

Staring into its face he saw pale ivory eyes.

Immediately realizing that this was his sister transformed, he summoned the Magician to his court. The old
man came, unrepentant. © | hese twenty years she has been a beast,” raved the Magician, "growing in a secret
cave, under my watchful eye. And now that she is fully grown, she will lay waste to your empire for me.”

Bur the Emperor challenged the Magician to a game of skill he had devised. Whoever won should control
the other. And with the encounter in the forest still foremost in his mind, the young man called his game
“Dragon’s Eye.”

Each tile was played with infinite patience. Four days passed as the antagonists pursued their contest. But
finally, as the fourth evening was falling, the Emperor won his game. Pale and exhausted, the old Magician
sat back— and for the first time smiled. “You have won,” he hissed through discolored teeth, “but the prize
you played for is illusory. I transformed your sister into a dragon, yes, but no power on earth or in heaven
can return her to her human state.”




“You misunderstand my desire,” replied the youth. "My sister has been a dragon all her life; she knows noth-
ing else. She could not be happy as a human being. But neither can she know happiness as the sole represen-
tative of her new race. So this is the prize you will give me: you will transform me into a dragon as well!”

Then he willingly submitted to the Magician's power, so that soon two dragons were seen in the empire —
a boy with Hashing black eyes, and a girl with eyes as pale as ivory.

how TO play dragon's eye

Gettmng started

Begin Dragon’s Eye by selecting New Game in the File menu, then choosing Dragon’s Eye from the listings.
(NOTE: On the Mac version you can begin Dragon’s Eye by selecting Choose Game in the Settings menu,
then choosing Dragon’s Eye from the listings.) In the DOS version, you will not be able to play Dragon’s
Eye as a Master, nor can you play the 2 player game, until you complete all four Rounds of a Tournament.
Once you complete a Tournament, Dragon’s Eye is added to the New Game listings in all modes.

the dragon display

On the left side of the screen is the Dragon display. When you start a game, eight tiles appear on the board.
The six face-up tiles are the Dragon’s “limbs” and the two face-down tiles are the Dragon’s “heart.” Should

they later become cleared, you'll see that the spaces beneath the limbs are light gray and the spaces beneath

the heart are dark gray.




At the bottom right side of the screen are five tiles; these form the Dragon Slayer’s hand. There are also three
tiles at the top right of the screen; these form the Dragon Master’s hand.

OBJECLIVE

The objective of the Dragon Master is to build the Dragon to full strength by filling all spaces on the display
one level high, and all spaces on the Dragon’s heart and limbs two levels high. The Dragon Slayer, on the
other hand, tries to remove all tiles from the “heart” and “limb” spaces. In either case, this is an automatic
victory for the player. Players gain points during a game as explained in the Scoring section.

how 1o play

The Dragon Master places tiles on the Dragon display to fill it up. The Dragon Slayer tries to remove
matching tile pairs from the display to empty it, but he must place a tile on the display if he can't find a
match,

A tile becomes blocked when tiles are placed adjacent to it on both sides and cannot be removed until it is
unblocked. Blocked riles are inverted. When the Dragon Slayer removes a tile that blocks others, the now-
unblocked riles turn face up and are available to be removed.

Second-level riles are placed only on eligible face-down tiles of the heart and limbs. These eligible tiles have
distinctive backs to indicate that they are eligible.

As soon as the last open space on the second level is filled, and the Dragon Slayer can't make any more
moves, the game ends. If all tiles are removed from the heart and limb spaces, the game ends. If all 144 ciles
have been drawn and played and the Dragon display is not completed or emptied, the game ends; in this
case, the players” scores are compared to determine the winner.




VARIALIONS

In the defaulr settings, you play Dragon’s Eye as the Dragon Slayer, with the computer playing the Dragon
Master. At the beginning of each round in a Tournament game, you play Dragon’s Eye in the mode you
chose for the Tournament, alternating, round by round, between Dragon Slayer and Dragon Master.

The Master and Slayer options are solitaire games. When you play solitaire against the computer, you see the
tile played by the computer if it’s placed face up on the display, but not if it’s placed face down. The tiles in
your hand are always face up.

In Challenge mode (two-player), players alternate turns as usual. Both hands are face down. When your
turn comes, have the other player look away and select Flip to turn your hand face up. When you finish
your turn by selecting Done, your hand automartically flips face down.

the dragon slayer’s turn

The Dragon Slayer always goes first. If you are playing Challenge against another player, select Flip to turn
the tiles in your hand face up. Note that there is a finger pointing to your hand when it is your turn. The
pointing finger is white when you can draw a tile or make a match. The finger turns gray after you've been
forced to discard a tile onto the display and can do nothing more except end your turn.

You have five tiles in your hand to begin with. As your turn begins, a sixth tile is automatically drawn for you.

You now try to remove matching tile pairs from the Dragon display. Removing tiles is the same as in
Shanghai. You select a tile in your hand or on the board and then select a matching tile. The tiles are
removed. You may remove as many tiles as you can or wish to.




If you ever have less than five tiles in your hand, you can immediately draw new tiles using the Draw button
on the display. You continue to march tiles until you no longer can or wish to.

If you have six tiles and can make no matches, you must discard one of the tiles in your hand onto the
Dragon display. Select the tile you wish to discard and then the space on the board where the tile is to go; the
pointing finger will turn gray. At the end of your turn, you can have a maximum of five tiles in your hand.

Once you've completed all available actions for a turn, select Done to end your turn; in the Challenge
mode, your riles will also flip over. The finger now points at the Dragon Master’s hand.

the draGgon master’s turn

The Dragon Master always goes second. When the finger points at your hand, it’s your turn. You start the
game with three tiles. In a two-player game, select Flip to turn your riles face up.

In your turn, you place one of these tiles on the board.

You face only one restriction when placing tiles. If any Dragon “heart” or "limb” space is open (they are the
light and dark gray spaces in the center of the display), you must fill this space, with a “heart” space having
precedence over a “limb.” If the “heart” and “limb” spaces are all filled, you can place the tile anywhere.

You will want to place tiles to block as many spaces as possible.

After you place a tile, the pointing finger turns gray. You must now draw another rile and end your turn.
Select Draw; if you forget to draw a tile at the end of your turn, the compurer will automarically draw one
for you. You can never have more than three tles in your hand.

Select Done to end your turn. In two-player mode, your hand will be Hipped when you select Done.




- SCRAteGY hiNts FOR dRAGON'S eyE

dragon slayer hnts

1) Keep drawing as many tiles as possible to continue making matches. Remove all matching tiles from

the board as soon as possible.

2)  If you have a matching pair in your hand, place one of the pair on one of the six spaces at the edges of
the Dragon that block two tiles each. You'll be able to unblock those spaces later at your convenience.

3) Don't worry too much about having to put tiles on the Dragon display. You will usually find “cascades”
happening, where matching pairs of tiles suddenly appear all around the display.

4)  If you must pur a tile on the display, try to place it in a space where it does not block others.

draGgon master hints

1) Although you have only three tiles in your hand, you control the pace of the game. Your objective is to
bury matching pairs so your opponent cannot remove them. Try to capture the six outer spaces on the
display that block two spaces each.

2)  Try to remember which tiles have been removed. If a pair has already been removed and you place a
third similar tile on one of the outer spaces, there is only one tile remaining that can be matched and
unblock the two tles.

3)  You will often have three tiles in your hand that match others on the display. Place the tile thar will do
the least damage by unblocking the minimal number of other spaces. You may be able to bury the more
damaging tiles in future moves.




— the tourRnament gGame

A Tournament game consists of four rounds. In each round you play four layouts: Dragon’s Eye, then three
levels of Shanghai (Easy, Advanced, and Master). You can play a Tournament in Solitaire or Challenge
(two-player) mode. Before the Tournament begins, you can enter player names using the New Game option
in the File menu. (NOTE: In the Mac version, use the Choose Game option in the Settings menu.) In the
Challenge mode, you must determine which player will go first throughout the Tournament.

SCORING

Dragon’s Eve Game Points: Shanghai Il Game Points:
PLAYER ACTION POINTS TIME/ACTION POINTS
Master * Slayer must place a tile on 30 minutes or less +1000
the display +1 30:01 to 60 minutes +500
» Either player places a tile 60:01 to 90 minutes +250
on top of another +10 90:01 to 120 minutes +100
e Filling the Dragon Display Using Shuffle ~100
{ Bringing the Dragon o life) +100 Using Find a March -10
Slayer » Removing a pair +2
e Clearing a Dragon Limb space +5
s Clearing a Dragon Heart space +10
* Clearing the Display
{Slaying the Dragon) +100




Shanghai scoring is based on time taken in playing. The faster you complete your three layouts, the higher
your score. A time penalty is applied for using the Find a Match or Shuffle Remaining Tiles oprions on
the Help menu. Note that in a Tournament game, the players’ respective times to finish the three Shanghai
layouts in a round are compared to determine the winner. Once the winner in a round is determined, the
clocks start at zero again.

In Challenge mode, the difference in time berween the two players on each Shanghai layour is awarded to
the player with the lower time, one point per second. At the beginning of each layout, there is a short pause
so that the players can study the board; no matches can be made during this time. All Shanghai games have
the Winnable Layout option on; players may turn this option off if they wish.

At the end of each round, the players’ scores appear after the reward sequence. Bonus points are awarded for
an automatic victory in Dragon’s Eye.

When you complete the final round in a Tournament game, the game shows your score (or both scores in

Challenge mode) and the Hall of Fame appears after the final reward sequence. Eligible scores are entered
in the Hall of Fame and highlighted.




difficulty of play

In each of the four Tournament rounds, the games increase in difficulty. All Tournament games can be played
in either Solitaire or Challenge mode. The order for the Tournament game is as follows —

ROUND ONE ROUND TWO ROUND THREE ROUND FOUR
Dragon’s Eye * Slayer * Master * Slayer * Master

Shanghai 11 * Boar (easy) * Snake (easy) * Dragon (easy) * Rar (easy)
* Dog (advanced) * Monkey (advanced) * Rooster (advanced) ¢ Ram (advanced)

* Rabbit {master) * (Jx (master) * Horse (master) . Tigr.:r (master)
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— Layout constRUuction set

You can create your own layouts, save them, and use them in Shanghai.

Ggetting started

DOS version: Call up the Construction Set oprion from the File menu.
Mac version: Call the Create Layout option from the Layout menu.

Windows version: Call up the New Layout option from the Construction menu.

A template grid appears on the screen. The grid has eight rows of fifteen spaces. Tiles must be placed within
the limits of the grid. You can create layouts up to six layers high.

A number at the upper right corner of the Menu bar tells you how many tiles are left to place. All complete
layouts must contain 144 tiles.

placing Tiles

To place a tile, select any space on the display with the mouse. A blank tile will appear. You can move this
tile around the board by selecting it and dragging it. To drag with the mouse, click on the tile with the left
button and while holding the button down, move the mouse across the display.

If you drag a selected tile off the edge of the display, it will disappear. If you drag it across a tile already on
the display, the dragged tile will be positioned on top of the other tile, up to a maximum of six layers.




You can place a tile directly on top of another tile. Once this tile is placed, you can reposition it as you wish

by dragging it.

In the DOS version, you can also place tiles by using a joystick or the keyboard. You can select any space on
the display by using the joystick button or by pressing Enter when using the keyboard. To drag a tile with
the keyboard, move the cursor over the tile with the arrow keys and press the Space Bar. The tile will be
highlighted. Move the tile around the board with the arrow keys, and press the Space Bar (or Enter) to
place it. The tile will move in half-space increments across the board. Once the tile is in the position you
want, release it.

If you decide to remove a tile, select it and drag it off the display. (NOTE: When using the keyboard with
the DOS version, select the tile and then press the Delete key.)

options

You can reposition all the tiles on the board by using the following keys on the DOS and Windows versions.

DOS Windows

F4 CTRL-L Moves the tiles one-half space to the left.
F5 CTRL-U  Moves the tiles up one-half space.

F6 CTRL-R  Moves the tiles one-half space to the right.
F7 CTRL-D  Moves the tiles down one-half space.




DOS version: You can also select these moves from the Options menu.
Mac version: You can also select these moves from the Manipulate menu.

Windows version: You can also select these moves from the Construction menu.

[f you move the tiles beyond the limits of the display, all tiles beyond the limit will disappear.

DOS version: You can turn the background grid on and off by selecting the Show Grid option in the
Options menu or by pressing F3.

Mac version: You can turn the background grid on and off by selecting the Show Grid option in the
Manipulate menu.

Windows version: You can turn the background grid on and off by selecting the Show Grid option in the
Construction menu.

player ClOoCks

When a new layour appears, you will see two buttons on the screen which are used for the clocks in the
Challenge mode. Your new layout must include these buttons. You can select and move these clock buttons
with the same procedures used for tiles.




saving and loading Layouts

DOS version: Save a layourt by selecting Save or Save As from the Game menu.
Mac version: Save a layout by selecting Save Layout or Save Layout As from the File menu.

Windows version: You save a layout by selecting Save Layout or Save Layout As from the Construction
menu.

Use Save (or Save Layout) if you are just starting a new layout or wish to copy over a layout you have
altered, and Save As (or Save Layout As) if you wish to save the layour under a new name. You can save to
a hard disk or a floppy disk.

DOS version: To load a layour for further editing, select Load Layout from the File menu, scroll through
the list, and select the layour you wish to work on. To load a layout for play, select Load Layout from the
Options menu and scroll through the list. Find the desired layour and select it. You can play the layout in
Solitaire or Challenge mode.

Mac version: To load a layout for further editing, select Open Layout from the File menu, scroll through
the list, and select the layout you wish to work on. To load a layout for play, select the desired layout from
the Layout menu. You can play the layout in Solitaire or Challenge mode.

Windows version: To load a layout for further editing, select Load Layout from the Construction menu,
scroll through the list, and select the layout you wish to work on. To load a layout for play, select Load
Layout from the Options menu and scroll through the list. Find the desired layout and select it. You can
play the layout in Selitaire or Challenge mode.
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- Tlle sets

You can play any layout, including your own layouts, with any of the cight tiles sets listed below. It is very
casy to make matches with some tile sets (Numbers and Letters, for example) while others are quite
challenging. (NOTE: For the DOS version, the tile set illustrations on the following pages represent the tiles
displayed in high resolution. Low resolution riles are not shown.)

DOS and Windows versions: To change tile sets, select the Options menu and then select Load Tile Set.

You can then select the new tile set by selecting the appropriate name and then the OK burtton.
Mac version: To change tile sets, select the desired tile set from the Tiles menu.

Note that if you start a new tile set in the middle of a game, you will automatically start a new game.

* Mah Jongg * Sports

* Playing Cards * Numbers and Letters (“Alphabet”)
* Flags of the World * Animals

* Fantasy World * Hanafuda




mah JONGG

Dragons
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Diragons

1. Red Diragon
2. White Dragon
3. Green Diragon

Winds

1. East Wind
2. West Wind
3. Norch Wind
4. South Wind
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Seasons
1. Spring
2. Summer

3, Autumn
4. Winter

Flowers

1. Orchid

2. Plum

3. Chrysanthemum

4, Bamboo




playmg Cards

The Playing Card tile set is used in
two variations: Lo-Hi and Hi-Lo.
Lo-Hi runs from the ace (as low
card) to the nine. Hi-Lo runs from
the six (as low card) to the ace. There
are no unique tiles in the Playing
Card set. You can select the variation
using the Load Tile Set from the
Options menu. Spades is shown
below — there are four of each tile.

(Hearts, Clubs, and Diamonds are
not shown.)




FlaGgs of The world
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Japan
. South Korea

. Yietnam
. India

. Taiwan
. Phillippines
. China

. Saudi Arabia

=l =Rt W RN N O

. United Kingdom
. Tnaly

. Germany

. Poland

r Sweden

7. Swirzerland

. Spain Miscellaneous
. LLS.SR. (DOS & Mac)

10. Russia (Windows)

Latin America

1. Ecuador Special

2. Venezucla
. Peru

3
4. Bolivia

5. aﬂrﬁ.cﬂth‘!-"- North America
6. Colombia 1. Canada

;- Panama 2. United States
I;r

. Uruguay 3. Mexico
. Brazl

9

Miscellancous Special

1. Egypt 1. Red Cross

2. .-""I.l.:l.l:lr:3|:i;l .l l_.ll'ljlﬂ'd H.lli{}r'lﬁ
3. Solomon Islands

4. Israel




Fantasy world

Ilﬂmw Creatures

% X

Armor
1. Suit of Armor

2. Shield
3. Helmet

Creatures agic PE%FIE Court Treasure
. Unicom 1. Bubbling Cauldron 1. Wizard 1. King 1. Ring

. Dragon 2. Magic Robe 2. Gnome . Crossbow 2. Queen 2. Gold Cup
. Hydra 3. Wand 3. Troll Ball Mace 3. Princess 3. Treasure Chest
. Minotaur 4. Magic Lantern 4. Gianr . Dagger 4. Jester 4. Big Gem
. Griffin 5. EIf . Bow & Arrow
. Roc 6. Halfling . War Axe
. Pegasus 7. Mermad . Spear
. Centaur 8. Knight . Mace

. Hippogniff 9. Leprechaun . Halberd
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Winter

1. Ski Jum

2. Downhill Racing
3. Figure Skatng

Team
1. Baseball
2. Football

3. Baskethall

4. Volleyball

5. Soccer

6. Lacrosse Individual

7. Polo 1. Horseshoes
8. Jai Alai 2. Golt

9. Hockey 3. Tennis

4., Ping Pong
Water 5. Croquet

1. Rowin 6. Badminton
2. Sailing 7. Gymnastics
3. Swimming 8. Bowling
4. Diving 9. Archery

Track & Field

. Hurdle

. Discus

. Shot Pur

. Hammer
Jum

: ngE Iumg

. Javelin

. Pole Vault

i R-Ela.}' RE.T.:F:

Hﬁ":b%-tﬂ"\-:h-hudl‘d—l

Individual Track & Field

Officials Medals

1. Baskethall Referee
2. Foortball Referee

3. Soccer Referee

4. Baseball Umpire

Medals

1. First Place

2. Second Place
3. Third Place
4. Fourth Place
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animals

Amphibians
1. Salamander
2. Frog

3. Newt

Canines
1. Bulldog
2. Terrier

3. S5t. Bernard
4. Poodle

5. Chihuahua
6. Fox

7. Grevhound
B. Collie

9, Wolf

Reptiles

1. Turtle

2. Crocodile

3. Snake

4. Monitor Lizard

Birds

. Swan

. Penguin

. Toucan

. Eagle

. Flamingo
. Chicken
. Cockaroo
. Parrot

. Pelican
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Salt Fresh
Water Water
Fish Fish

. Persian Cat
. Cheetah
. Leopard

E
. Black Pancher
, Siamese Car
. Bobcar

Salt Water Fish
1. Opah

2. Swordhish

3. Shark

4. Pulfer

Fresh Water Fish
1. Koi

2. Rainbow Trout
3. Cartfish

4. Sunfish
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the twelve animals of time

In the 61st year of the reign of Emperor Huang Ti, which others call 2637 BC, the aged Emperor intro-
duced a lunar calendar—a calendar which is still in use today in the East. It is measured by a 60-year outer
cycle, broken into five inner cycles of twelve years each. Each year begins with the new moon in the time
we call Aquarius, sometime in January or February. The 78th outer cycle of the lunar calendar began on
February 2, 1984 and will run until January 30th, 2044.

Now in the last year of the life of Siddhartha Gautama, the Buddha, which others place near 483 BC, that
holy man called the animals of the earth to come to him, that he might bid them farewell. Bur of all the
animals, only twelve responded to his call. As their reward he named the twelve years of the inner cycles for
them in the order thar they arrived. First there was the Rat, then the Ox, then the Tiger, the Rabbir, the
Dragon, the Snake, the Horse, the Ram, the Monkey, the Rooster, the Dog, and lastly the Boar.

In the centuries since, men and women born during an animal’s year have been seen to exhibit the charac-
teristics of that animal. Shanghai players have found insight into humanity by playing layouts based on the
animals. Now you have the chance to learn the secrets for yourself...
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: VEARS

The Rat person is always busy, always sociable. January 31, 1900 - February 18, 1901
He hurries hither and yon, involved in bl% pro- Februaty, 18, 1918—Pebruary 5, 1913
jects (sometimes too big for his changeable

nature). But however his projects turn out, he February 5, 1924~ January 24, 1925
seems to have all he needs— primarily because January 24, 1936~ February 10, 1937
he makes efficient use of everything he has. A{}d February 10, 1948 — January 28, 1949
if he is ever disappointed, he hides it well. He's January 28, 1960— February 14, 1961
the one who keeps his head when everyone
about him is losing theirs, which is why he’s February 15, 1972 - February 2, 1973
generally at the head of the pack. February 2, 1984 — February 19, 1985

February 19, 1996 — February 6, 1997

people events

Peter the Great, 1672 America discovered, 1492

George Washington, 1732 Poor Richard’s Almanac published, 1732

Louis Armstrong, 1900 Democratic Party founded, 1792

Clark Gable, 1901 Telephone invented, 1876

Marlon Brando, 1924 First National Baseball League tormed, 1876
Jimmy Carter, 1924 Lictle Big Horn, 1876

Prince Charles, 1948 The Commonwealth of Australia created, 1900







VEARS

The Ox person is a hard worker— dependable, February 19, 1901-February 7, 1902
methodical and tireless. The dimcult}* comes Pebriary 6, 1913 abuary 25, 1914

when you want him to change his course. The B ik, wk 4 00
Ox lowers his head and goes for the gold— I A S by 12, 1920
if you're not in his way or even going the other February 11, 1937~ January 30, 1938
direction, you'll naturally applaud his fortitude January 29, 1949 — February 16, 1950
and follow where he leads. He has a greart respect February 15. 1961—February 4. 1962
for system and tradition; he'll get the best out of st i
what's to be had. February 3, 1973 - January 22, 1974

February 20, 1985 February 8, 1986

February 7, 1997 - January 27, 1998

people events

Ludwig van Beethoven, 1770 Discovery of Uranus, 1781

Adolf Hitler, 1889 Capitol Building begun, 1793

Gary Cooper, 1901 Edison announces phonograph, 1877
Walt Disney, 1901 First Charlie Chaplin film, 1913

Charles Lindbergh, 1902 Chicago-style jazz arrives in Europe, 1925
Gypsy Rose Lee, 1914 First man in space, 1961

Johnny Carson, 1925 Berlin Wall built, 1961







The Tiger person is the essence of a king —
loaded wul'F: power, yet constrained to use it
wisely. As a cub he’s quite a swashbuckler,
dashing off wherever adventure awaits, but as
an adult he’s content to keep the home fires
burning. The world arnunclphlm enlivens him,
wherever he may be, and he in turn, enlivens
the world. Just don't forget that he has claws
for when he needs them.

people events

VEARS

February 8, 1902 - January 28, 1903
January 26, 1914 — February 13, 1915
February 13, 1926 — February 1, 1927
January 31, 1926 - February 1, 1927
January 31, 1938 — February 18, 1939
February 17, 1950 February 5, 1951
February 5, 1962 - January 24, 1963
January 23, 1974 — February 10, 1975
February 9, 1986 — January 28, 1987
January 28, 1998 — February 15, 1999

Charles de Gaulle, 1890 Republican Party founded, 1854

Agatha Christie, 1890 First General Election in Japan, 1890

Ansel Adams, 1902 Panama Canal opened, 1914

Zsa Zsa Gabor, 1915 Ernest Hemmingway's The Sun Also Rises published, 1925
Queen Elizabethll, 1926 Orson Welles' “War of the Worlds,” 1938

Marilyn Monroe, 1926 Nixon resigns, 1974

Peter Jennings, 1938 Activision releases Shanghai [, 1986
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: VEARS

The Rabbit glides through life because he under- January 29, 1903 — February 15, 1904
stands the ways of hurqﬂnit}c This may lead him February 14, 1915 — February 2, 1916
towards selfless dedication to others, or toward

. : February 2, 1927 - January 22, 1928
self-indulgence at others’ expense, but he always o
knows what he is doing and why. Sometimes the February 19, 1939 — February 7, 1940
understanding overwhelms him and he retires to February 6, 1951 - January 26, 1952
!115 |_:|ur1‘-:}w, but soon he’s back out, letting his January 25, 1963 —February 12, 1964
instincts lead him smoothly through the crowds ; |
to all the carrots he can handle. February 11, 1975 - January 30, 1986

January 29, 1987 — February 16, 1988

February 16, 1999 — February 2, 2000

people events

Albert Einstein, 1879 Alaska becomes American, 1867

George Orwell, 1903 Dominion of Canada formed, 1867
Cary Grant, 1904 Panama Canal Treaty, 1903

Billie Holiday, 1915 First airplane flight, 1903

Hugh Hefner, 1927 First Transatlancic flight, 1927

Andy Warhol, 1927 Beer Barrel Polka becomes popular, 1939
Mark McGwire, 1963 First TV broadcast in US, 1951







T'he Dragon is a mover and a shaker. When
compiling the list of famous people for the
twelve Animal signs, the Dragon group quickly
became twice as large as any other group. Ego-
tistical, eccentric and powerful, these people
don’t mind Iettini}rnu know they are better

than you — but the thing is, they can back it
up. Dragons are feared in Western fables, but
in the East, they are revered.

people events

VEARS

February 16, 1904 — February 3, 1905
February 3, 1916 —January 22, 1917
January 23, 1928 — February 9, 1929
February 8, 1940 - January 26, 1941
January 27, 1952 - February 13, 1953
February 13, 1964 — February 1, 1965
January 31, 1976 — February 17, 1977
February 17, 1988 — February 5, 1989
February 5, 2000 - January 23, 2001

Abraham Lincoln, 1809 First telegraph message, 1844

Sigmund Freud, 1856 Andrew Johnson impeached and acquirred, 1868
Helen Keller, 1880 BINGO developed in Italy, 1880

Dr. Seuss, 1904 Elizabeth becomes queen, 1952

Martin Luther King Jr. 1929

Beatles invade America, 1964

John Lennon, 1940 The Viking I lands on Mars, 1976

Jose Canseco, 1964
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The Snake person has great depth within him.
Wisdom is ﬂis. as is sensuality and intensity —
though he may appear on stage, the real li?ﬂr for
him is behind closed doors, where he can exer-
cise his powers without explaining them to those
who will never understand. Those powers are
leading him somewhere, and while others can
fail to find their way in life, the Snake must go
all the way to his end, whatever it may be.

———— e e

people events

Mahatma Gandhi, 1869 Boston Tea Party, 1773

VEARS

January 4, 1905 - January 24, 1906
January 23, 1917 - February 10, 1918
February 10, 1929 - January 29, 1930
January 27, 1941 — February 14, 1942
February 14, 1953 — February 2, 1954
February 2, 1965 - January 20, 1966
February 18, 1977 — February 6, 1978
February 6, 1989 — January 26, 1990
January 24, 2001 — February 11, 2002

Greta Garbo, 1905 Einstein formulates Special Theory of Relativity, 1905
Howard Hughes, 1905 Ty Cobb begins his baseball career, 1905

John E Kennedy, 1917 First Zeppelin flies around the world, 1929

Grace Kelly, 1929 First conquest of Mt. Everest, 1953

Jesse Jackson, 1941 Ford introduces the Mustang, 1965

Muhammad Ali, 1942







VEARS

The Horse is straightforward making life easy January 25, 1906 — February 12, 1907
for himsc]fﬂ]t:f:l Eﬂi_‘]r}'(.]nﬁ‘ amund(lilim. ]_f he February 11, 1918 - January 31, 1919
wants something, he just goes and gets it,

though often he finds someone else handing it January 30, 1930 February 16, 1931
over without asking. He’s an adventurer, pri- February 15, 1942 - February 16, 1931
marily because he has the strength and endur- February 15, 1942 — February 4, 1943

because he can’t deny himself the opportunirty
to make use of his talents.

January 21, 1966 — February 8, 1967
February 7, 1978 - January 27, 1979
January 27, 1990 — February 14, 1991
February 12, 2002 - January 31, 2003

people events

Davy Crockert, 1786 Gregorian Calendar adopted, 1582

MNeil Armstrong, 1930 Mexican-American War, 1846

Sean Connery, 1930 Discovery of Neptune, 1846

Ray Charles, 1930 San Francisco earthquake, 1906

James Dean, 1931 Discovery of Pluto, 1930

Aretha Franklin, 1942 J. R. R. Tolkien's Lord of the Rings, 1954
Paul McCartney, 1942 Reunification of Germany, 1990







The Ram is a creative person, looking for ways
to enhance the enjoyment of the flock. Not that
he'll do anything for the Hlock — he can be
hard-headed if he has to be — but if others are
happy then they won't bother him. Because of
the ﬁarmnn}r he creates, more powerful people
take a liking to him and help him in his endeav-
ors, so that in the end, he gets exactly what he
wants out of life, without ever pushing anyone
around.

people events

VEARS

February 13, 1907 — February 1, 1908
February 1, 1919 — February 19, 1920
February 17, 1931 — February 5, 1932
February 5, 1943 — January 24, 1944
January 24, 1955 — February 11, 1956
February 9, 1967 - January 29, 1968
January 28, 1979 - February 15, 1980
February 15, 1991 — February 3, 1992
February 1, 2003 - January 21, 2004

Rudolph Valentino, 1895 Jamestown founded, 1607

John Wayne, 1907 First Chicago skyscraper built (10 stories!), 1883
Cab Calloway, 1907 Brooklyn Bridge opened, 1883

Liberace, 1919 Prohibition enacted, 1919

Mikhail Gorbachev, 1931 Empire State Building opens, 1931

Leonard Nimoy, 1931 First modern UFO sightings, 1943

George Harrison, 1943 Rosa Parks ignites the Civil Rights movement, 1955







VEARS

The Munkf:ﬁ person uses his mind more than his February 2, 1908 — January 21, 1909
mass. Like the little animal that cla{nEEr_s around February 20, 1920 — February 7, 1921
in the treetops, the Monkey persons brain is February 6, 1932  January 25, 1933
always in action. He likes pitting himself against ;
others so he can demonstrate his ability to out- January 25, 1944 — February 12, 1945
maneuver them. His biggest problem is knowing February 12, 1956 - January 30, 1957
}Mhﬂﬂ to settle for wh.-a_lt Ehas, as o pﬂs_cd to try- January 30, 1968 — February 16, 1969
ing “just one more thing.” Or maybe his prob-
lem is failing to believe that that is the problem.

February 16, 1980 — February 4, 1981
February 4, 1992 - January 22, 1993
January 22, 2004 — February 8, 2005

people events

Leonardo da Vinci, 1452 Pilgrims arrive at Plymouth, 1620

Bette Davis, 1908 United States of America formed, 1776

lan Fleming, 1908 Gold discovered in California, 1848

Timothy Leary, 1920 Communist Manifesto, 1848

George Lucas, 1944 Confederate States of America, 1861

Joe Montana, 1956 Amelia Earhart flies solo across the Atlantic, 1932

Transatlantic cable telephone service begun, 1956
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VEARS

The Rooster seems to be the cock of the walk, January 22, 1909 — February 9, 1910

but that flair for performance masks a deeply February 8, 1921 — January 27, 1922

conservative streak. He makes sure thar all of his ] 26. 1933 Feb 13, 1934
chicks have what they need. He's not nearly as U @ E_ SRREY a1
confident as he seems, but he never lets those February 13, 1945 — February 1, 1946
counting on him know it. He loves to FECI{ January 31, 1957 = February 17, 1958
away at your life — albeit in a seemingly playful February 17, 1969~ February 5, 1970

manner, but he does not like having his own
feathers ruffled. February 5, 1981 - January 24, 1982

January 23, 1993 - February 9, 1994
February 9, 2005 - January 28, 2006

people events

Catherine the Great, 1729 Washington elected first President, 1789

Richard Wagner, 1813 Peary discovers North Pole, 1909

Amelia Earhart, 1897 First United Nations General Assembly in London, 1946
Errol Flynn, 1909 Sputnik launched, 1957

John Glenn, 1921 “West Side Story” opens on Broadway, 1957

Eric Clapton, 1945 First man on the moon, 1969

Arsenio Hall, 1957 Woodstock, 1969







There’s no real mystery about the Dog person.
He's always straightforward, ready to come to
the aid of his friends and go for the throat of
his enemies. If you betray his trust, he'll let you
know about it, bur he won't write off the whole
relationship. He may become a bit cynical over
time, but rli::ar's because he had no cynicism at
all when he was a pup. But even so, he'll never
stop believing that what he does matters.

people events

Winston Churchill, 1874 LaSalle claims Louisiana

VEARS

February 10, 1910 - January 29, 1911
January 28, 1922 — February 15, 1923
February 14, 1934 — February 3, 1935
February 2, 1946 - January 21, 1947

February 18, 1958 — February 7, 1959
February 6, 1970 - January 26, 1971

January 25, 1982 — February 12, 1983
February 10, 1994 — January 30, 1995
January 29, 2006 — February 17, 2007

Territory, 1682

Albert Schweitzer, 1875 Philadelphia becomes first US capital, 1790
Sam Donaldson, 1934 British burn Washington, D.C., 1814

Elvis Presley, 1935 California gains statehood, 1850

Connie Chung, 1946 Greater New York established, 1898

Rickey Henderson, 1958 NASA established, 1958
Prince, 1958 First Earth Day, 1970







The Boar is renowned for his fortitude; once he
decides to do something, he perseveres until it’s
done. Of course, he may have to ignore other
considerations and commitments in his quest
for results, but he’s so natural about it that peo-
le he slights rarely hold it against him. He does
]?li!i best to make it up afterward, and since he
doesn’t look at anything as a problem he cant
overcome, he generally succeeds ar that, too.

eople
ﬁiﬁtcr CEWI#:}’. 1875
Alfred Hichcock, 1899
Ronald Reagan, 1911
Roy Rogers, 1911
Hank Williams, 1923
Luciano Pavarorti, 1935
Woody Allen, 1935

events

VEARS

January 30, 1911 - February 17, 1912
February 16, 1923 — February 4, 1924
February 4, 1935 — January 23, 1936
January 22, 1947 — February 9, 1948
February 8, 1959 - January 27, 1960
January 27, 1971 - February 14, 1972
February 13, 1983 — February 1, 1984
January 31, 1995 — February 18, 1996
February 18, 2007 - February 6, 2008

Louisiana Purchase, 1803

Andrew Jackson defeats British at New Orleans, 1815
Vulcanized rubber patented, 1839

Emancipation Proclamation, 1863

Jackie Robinson breaks baseball color barrier, 1947
Hawaii made 50th state, 1959

Voting age lowered to 18, 1971




52

— CUSTOMER SERVICE

If you have any comments, questions or suggestions about Shanghai II or any other Activision product, you
can contact us at (310) 479-5644 berween the hours of 9:00 a.m. and 5:00 p.m. Pacific Time or contact a
customer service representative through the following on-line services:

CompuServe: 76004,2122 or [GO GAMEPUB] in the Game Publishers Forum B

Prodigy: ACTI10B

GEnie: ACTIVISION

America OnLine: MEDIAJAKE or use keyword “ACTIVISION" to locate the Activision forum.
Internet: support@activision.com

For customer service outside of the U.S. refer to the RETURNS section at the end of this manual.




ACTIVISION 90-day WARRANTY & COPYRIGHT INFORMATION

This software product and the attached instructional materials are sold “AS 15,” without warranty as to their performance. The
entire risk as ro the quality and performance of the computer software program is assumed by the user. However, to the original
'ur:hmr, Activision, Inc. warrants the medium on which the program is recorded to be free from defects in materials and faulty
mri.manship under normal use and service for a period of ninety (90) days from the date of purchase. If during this period a
defect on the medium should occur, the medium may be returned to Activision, Inc. or the place of purchase, and Activision,
Ine. will replace the medium without charge w you. Your sole and exclusive remedy in the event of a defect is expressly limited

to replacement of the medium as provided above. This warranty gives you specific legal rights; you may also have other rights
which vary from state to state,

The above warranties for goods are in lieu of all warranties, express, implied or statutory, including, but not limited to any
implied warranties of merchantability and fitness for a particular purpose and any other warranty obligation on the part of
Activision, Inc. Some states do not allow limitations on how long an implied warranty lasts so that above limitation may not
apply to you. In no event shall Activision, Inc. or anyone else who has been involved in the creation and production of this com-
puter software program be liable for indirect, special or consequential damages, such as, but not limired ro loss of anticipated
profits or benefits resulting from the use of this program, or arising out of any break of this warranty. Some states do not allow

the exclusion or limitation of incidental or consequential damages, so the above limiration may not apply to you.

After the warranty period, a defective Activision disk may be returned to Activision, Inc. with a check or money order for $5.00
(U.S. currency) per disk for replacement. Copyright: The enclosed software product is copyrighted and all rights are reserved by
Acrivision, Inc. The distribution and sale of this product are intended for the use of the original purchaser only and for use only
on the computer system specified. Lawful users of this program are hereby licensed only to read the program from its medium to
memory of a computer solely for the purpose of executing the program. Copying, duplicating, selling or otherwise distributing
this product is violation of the law. This manual and all other documentation contained herein are copyrighted and all rights
reserved by Activision, Inc. Willful violations of the Copyright Law of the United States can result in civil damages of up 1o
$50,000 in addition to actual damages, plus criminal penalties of up to one year imprisonment and/or $10,000 fine.

Copyright ©1994 Activision, Inc.
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RECURNS

Certified mail is recommended for returns. For best service, please be sure to:

—
=

Send only the original product disks (in protective packaging).

b

Include a photocopy of your dated sales receipt.

3. Enclose:
* a brief note with your name and return address (typed or printed clearly),

* a description of the problem(s) you have encountered with the software,
* name of the product,

* the brand and model name (and/or model number) of your computer.
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In the U.S. send to:
WARRANTY REPLACEMENTS

Activision

PO. Box 67713

Los Angeles, CA 90067
USA

(310) 479-5644

In Australia send to:
WARRANTY REPLACEMENTS

Acrtivision

10 Anges Street
Meadowbank, NSW 2114
Australia

(61) 2 809 4444

In Europe send to:
WARRANTY REPLACEMENTS

Activision

Long Island House, 3A
1/4 Warple Way
London, W3 ORG
United Kingdom

(44) 081 742 9400

ACTIVISION.

Copyright ©1994 Activision, Inc.

Printed in the U.S.A.
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